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1. INTRODUCTION 

WinSteam provides a library of steam property functions for Windows applications based on 
the formulations published by the International Association for the Properties of Water and 
Steam (IAPWS). WinSteam includes forty-three accurate functions, which normally use the 
IAPWS-IF97 formulations, but at the user’s option, can use the 1967 IFC formulations. In 
January 1999, the American Society of Mechanical Engineers (ASME) declared that the 1997 
formulations should be used for all future work.  The 1967 formulations, however, may be used 
for analyses involving previously developed contract requirements.  You can use WinSteam 
3.2 in either situation.   

The WinSteam package includes DeskTop Steam, an interactive steam property calculator, 
and various add-ins which allow the functions to be used as if they were built in to 1-2-3 for 
Windows, Microsoft Excel, and Mathcad.  Programmers can call the functions, which reside in 
a dynamic link library, directly from many Windows programming languages such as 
Microsoft's Visual Basic, Visual C++ and Access. 

Both the 1997 and 1967 formulations in WinSteam have been extensively tested and found to 
replicate published sources. For a complete discussion of add-in timings and accuracy see 
section 4 of this manual. 

WinSteam supports the full ranges defined valid by each set of formulations.  The functions 
detect requests for calculations outside those ranges and return an error value.  The ranges in 
which the routines are valid are described in section 2.6 of this manual. 

WinSteam 3.2 supports only 32-bit applications.  If you are using Windows 3.1 or 16-bit 
applications, please contact Techware for other options. 

The Setup program and the installation instructions contained in the WinSteam package guide 
you through installing the files you'll need for the applications you expect to use.  Example files 
to help you get started will also be installed. 
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2. USING THE STEAM PROPERTY FUNCTIONS 

2.1 GENERAL APPROACH 

All applications acquire steam properties by using the same set of forty-three functions.  In 
most applications, the functions are called by name.  In DeskTop Steam, the appropriate 
functions are called automatically according to your on-screen selections. 

Each user of spreadsheets or programs you write using the steam property functions must 
have his own copy of WinSteam. You are not licensed to distribute any of the WinSteam files 
without permission from Techware.   

In Excel, 1-2-3, Mathcad, Visual BASIC and your own Window's programs, the functions 
provided by WinSteam can be used within equations just like each application's built-in math 
functions.  The functions can even be nested.  Each function returns a single, floating point 
result.  The functions require either one or two inputs to identify the state point and an extra 
parameter to designate the unit set and other options.  Subsequent sections of this chapter 
describe the calling syntax and other considerations in using the functions within supported 
applications.   

The following table summarizes the forty-three functions together with their inputs and outputs.   
 

Function Input(s) Output             
StmPT() Pressure Saturation Temperature 
StmTP() Temperature Saturation Pressure 
StmTQH() Temperature, Quality Enthalpy 
StmTQS() Temperature, Quality Entropy 
StmTQV() Temperature, Quality Specific Volume 
StmTQC() Temperature, Quality Specific Heat 
StmTQK() Temperature, Quality Thermal Conductivity 
StmTQM() Temperature, Quality Dynamic Viscosity 
StmTQW() Temperature, Quality Sonic Velocity 
StmTQG() Temperature, Quality Isentropic Expansion Coefficient 
StmPQH() Pressure, Quality Enthalpy 
StmPQS() Pressure, Quality Entropy 
StmPQV() Pressure, Quality Specific Volume 
StmPQC() Pressure, Quality Specific Heat 
StmPQK() Pressure, Quality Thermal Conductivity 
StmPQM() Pressure, Quality Dynamic Viscosity 
StmPQW() Pressure, Quality Sonic Velocity 
StmPQG() Pressure, Quality Isentropic Expansion Coefficient 
StmPTH() Pressure, Temperature Enthalpy 
StmPTS() Pressure, Temperature Entropy 
StmPTV() Pressure, Temperature Specific Volume 
StmPTC() Pressure, Temperature Specific Heat 
StmPTK() Pressure, Temperature Thermal Conductivity 
StmPTM() Pressure, Temperature Dynamic Viscosity 
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StmPTW() Pressure, Temperature Sonic Velocity 
StmPTG() Pressure, Temperature Isentropic Expansion Coefficient 
StmPHT() Pressure, Enthalpy Temperature 
StmPHS() Pressure, Enthalpy Entropy 
StmPHV() Pressure, Enthalpy Specific Volume 
StmPHQ() Pressure, Enthalpy Quality 
StmPHC() Pressure, Enthalpy Specific Heat 
StmPHW() Pressure, Enthalpy Sonic Velocity 
StmPHG() Pressure, Enthalpy Isentropic Expansion Coefficient 
StmPST() Pressure, Entropy Temperature 
StmPSH() Pressure, Entropy Enthalpy 
StmPSV() Pressure, Entropy Specific Volume 
StmPSQ() Pressure, Entropy Quality 
StmPSC() Pressure, Entropy Specific Heat 
StmPSW() Pressure, Entropy Sonic Velocity 
StmPSG() Pressure, Entropy Isentropic Expansion Coefficient 
StmTEMPIT() Temperature, 1968 scale Temperature, 1990 scale 
StmTEMPTI() Temperature, 1990 scale Temperature, 1968 scale 
StmVER() None Version/serial no. 

 
For C prototypes of the functions, see the Stm32Proto.h file in the \Programming subdirectory 
of the \WinSteam directory created on your hard disk by the installation program. 

2.2 USING THE STEAM FUNCTIONS 

Theoretically, a point can be uniquely identified by specifying any two of the six thermodynamic 
properties.  In most practical applications, however, pressure and one other variable are 
known.  The functions contained in WinSteam are limited to such situations.  Supported 
combinations are: 

 (P)ressure and (T)emperature 
 (P)ressure and Ent(H)alpy 
 (P)ressure and Entropy(S) 
 (P)ressure and (Q)uality (wet region only) 
 (T)emperature and (Q)uality (wet region only) 

 
To obtain the properties of saturated water or steam, use the pressure/quality or 
temperature/quality functions with quality set to 1 for saturated vapor or 0 for saturated liquid. 

2.2.1 Using WinSteam from Excel 
WinSteam 3.2 supports only 32-bit versions of Microsoft Excel.  As of this writing, available 
32-bit versions include Excel 7 and Excel 97, Office 2003 and Office 2007. 

You must load the XLSTM32.XLL add-in to access the steam property functions from Excel.  
Loading this add-in brings the functions into memory and links them to Excel.  You load the 
XLSTM32 property functions into Excel using the Add-in Manager. 

Use the Tools Add-Ins menu selection to start the Add-In Manager. (In Office 2007, click the 
Office button, then click the “Excel Options” button, then select the Add-ins tab and click the 
“Go…” button at the bottom.)  If installed using the default values, the file XLSTM32.XLL 
should be in the \OFFICE\LIBRARY directory and the Add-In Manager will show that 
"WinSteam for Excel" is available.  If you do not see “WinSteam for Excel”, click the “Browse” 
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button and find the file XLSTM32.xll.  It should be in the C:\Program Files\Microsoft 
Office\OfficeXX\Library directory, where OfficeXX is the latest Office version installed.  Click 
the check box next to “WinSteam for Excel” and press OK. The Techware copyright notice will 
appear in the status bar each time the add-in is loaded. 

Once selected this way using the Add-in Manager, the functions will be loaded automatically, 
each time you start Excel.  If you wish to unload the functions, use the Add-In Manager and 
uncheck the box labeled “WinSteam for Excel”.  Thereafter, WinSteam for Excel will not load 
until you select it again using the Add-In Manager as described above. 

Once the add-in is loaded, the steam property functions are available in the same ways as 
Excel's built-in functions.  That is, they can be typed into cell formulas or they can be inserted 
by pressing the fx button while creating a cell equation or using the Formula Paste Function 
menu selection.  (In Office 2007, these can be found on the “Formulas” tab.)  When using 
either of the two latter methods, the steam property functions will be alphabetically sorted in a 
function category called “Engineering”.  Generally, you can use any of the functions listed in 
Chapter 2 in any cell formula.  Be sure to prefix the function name with an "=" character if it is 
the first or only item in a formula.  The line below presents an example of a call to a steam 
property function from Excel: 

=StmPTH(a1,b1,”Eng”) 
 
After installation, the SAMPLES subdirectory to the WINSTEAM directory created on your hard 
disk includes a sample Excel spreadsheet named EXAMPLE.XLS, which makes several 
typical calls to the steam property functions. 

Since the steam property functions make many floating-point calculations, they can add to a 
spreadsheet's recalculation time.  You may find it desirable to set recalculation to manual 
rather than automatic through the Tools Options Calculation menu selection. 

The WinSteam for Excel add-in can work in any of the unit systems or modes described in 
section 2.3.  Different unit systems can even be mixed in the same spreadsheet.   

2.2.2 Using WinSteam from 1-2-3  
You must load the add-in file named AFSTEAM.12A to access the steam property functions 
from 1-2-3. When the add-in is loaded into memory it establishes links between 1-2-3 and the 
WinSteam libraries. 

Use the File, Add-Ins, Manage Add-ins menu selections to start the Add-In manager.  Before 
you can use the WinSteam add-in for the first time, you must register the add-in by pressing 
the 'Register..' push-button.  If installed using the default values, the file AFSTEAM.12A should 
be in the \LOTUS\123\ADDINS directory and will be shown in the Register Add-Ins window.  If 
you installed the file elsewhere, you will have to use the 'Look in' window to search for the file.  
When you have located the AFSTEAM.12A file, select it and press the  'Open' push-button.   
The add-in is now registered. 

To load the add-in after it is registered, click on the path name that has the AFSTEAM.12A file.  
A check mark will appear to the left of the path name indicating that the add-in is selected.  
Press the 'Done' push-button to complete the task.   

Thereafter, each time you start 1-2-3, the functions will be loaded automatically.  If you wish to 
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unload the functions, use the Add-In manager and uncheck the add-in.  Thereafter, the 
AFSTEAM.12A add-in will not load until you select it again using the Add-In manager as 
described above but it should be unnecessary to go through the registration process again. 

Once the add-in is loaded, the steam property functions can be used in any cell formula by 
typing the function name in the same ways as 1-2-3's built-in functions.  If you need help, use 
the 1-2-3 Help menu and select the 'WinSteam Help' item.  This will launch an interactive help 
window, which provides information regarding the functions and their usage. 

When the add-in is loaded, the steam property functions are available in the same ways as 1-
2-3's built-in functions.  That is, they can be typed directly into cell formulas.  Generally, you 
can use any of the 43 functions listed in section 2.1 in any cell formula simply by prefixing the 
function name with an "@" character.  The WINSTEAM\SAMPLES directory includes a sample 
1-2-3 spreadsheet named EXAMPLE.123, which makes several typical calls to the steam 
property functions.  The line below presents an example of a call to a steam property function 
from 1-2-3: 

@StmPTH(a1,b1,”Eng”) 
 

This syntax actually calls an add-in function in the AFSTEAM add-in.  These add-in functions 
perform error checking and return an appropriate 1-2-3 error value (e.g., ERR) when 
necessary - typically when input arguments are out of range or when too many arguments are 
supplied to the function.  1-2-3 will not accept a cell formula that contains a function reference 
with too few input arguments.  The AFSTEAM add-in functions themselves call functions in the 
WinSteam library to actually perform the calculations. 

The AFSTEAM add-in can use any of the unit systems described in section 2.3.  Different unit 
systems can even be mixed in the same spreadsheet.   

2.2.3 Using WinSteam from Mathcad 
The WinSteam add-in for Mathcad is a self-registering dynamic link library (DLL).  All that is 
required for Mathcad to access the functions is that the add-in file, MDCSTM32.DLL, be 
located in the MATHCAD\USEREFI directory.  Whenever a WinSteam function is used, 
Mathcad will automatically load and register the function. 

The WinSteam add-in for Mathcad allows the use of any of the unit systems described in 
section 2.3.  Mathcad, however, allows only pure numbers (without units) to be passed to and 
from user-defined functions such as these calls to WinSteam.  The last argument in each 
function call is the unit set designator and can use values as described in section 2.3.  The 
other arguments to the functions must be numbers without units whose values are consistent 
with the selected unit set. 

The SAMPLES subdirectory to the WINSTEAM directory created on your hard disk contains a 
sample Mathcad file named EXAMPLE.MCD, which makes typical calls to the steam property 
functions and illustrates the use of the unit set designator. 

Although on-line help for WinSteam is not directly available from within Mathcad, Mathcad 
does recognize the WinSteam functions and assists user in assembling calls to the functions.  
In Mathcad Plus 6.0 Use the Math, Choose Function menu selections to open the Choose 
Function window.  Scroll down the 'Function name is' box to find all the steam functions listed 
in alphabetical order.  The 'Returns' box will describe the input arguments and the return value 
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for the function that is selected.  Pressing the 'Insert' push-button will copy the function to your 
worksheet with placeholders for each function argument.  In Mathcad 8, use the Insert, 
Function command menu selections to open the Insert Function window.  Select the 
Engineering category in the left-hand pane of that window and select the desired function in 
the right-hand pane.  Press the ‘Insert’ push-button to copy the function call into your 
worksheet. 

2.2.4 Using WinSteam from Visual BASIC 
The steam property functions can be used directly in your Visual Basic programs just like the 
built-in functions.  Before the functions can be used, however, they must be declared as 
functions and Visual BASIC must be told where to find them.  This can all be accomplished by 
including a DECLARE statement for each of the steam property functions in either the Form 
code or in the Global code.  The DECLARE statement must include the name of the function, 
the dynamic link library where it can be found (TSTEAM32.DLL) and the list of arguments 
(which must all be passed by value, 'ByVal').  A sample DECLARE statement is as follows: 

Declare Function StmPT Lib "TSTEAM32.DLL" (ByVal P As Double, ByVal Units As 
Integer) As Double 

The file named STEAMDEC.TXT contains a complete set of declarations for Visual BASIC. 

If you are using the WinSteam functions in an Excel Visual Basic module to create additional 
functions, you should use a different name to declare the functions or else they will conflict with 
the functions in the XlStm.xll add-in.  In this case, you must use the ALIAS keyword in the 
declaration to identify the true name in the DLL.  For example, 

Declare Function MyStmPT Lib "TSTEAM32.DLL" ALIAS "StmPT" (ByVal P As 
Double, ByVal Units As Integer) As Double 

The file named TSTEAMVBADEC.TXT contains a complete set of declarations for Excel Visual 
BASIC. 

With each steam function call, your code should check to ensure that the values returned are 
greater than -1000.  Return values of -1000 or smaller (more negative) indicate error 
conditions.  See the Appendix for a listing of error codes and their meanings. 

2.2.5 Using WinSteam from Windows Programming Languages 
The steam property functions in TSTEAM32.DLL can also be called from your own programs 
compiled to run under Windows.  Prototypes for all functions must be declared near the top of 
the source file.  This is most easily done by including (using the include compiler directive) 
the file named 'Stm32Proto.h'. All files needed to support your programming applications can 
be found under the \WINSTEAM directory if you chose the default directory during installation.   

You may also find it convenient to include the file named 'Stmerr.h'.  It defines mnemonic 
constants for the various error values returned by TSTEAM32.  The compiled code should also 
be linked with the import library named ‘TSTEAM32.LIB’. 

With each steam function call, your code should check to ensure that the value returned is 
greater than -1000.  Return values of -1000 or smaller (more negative) indicate error 
conditions.  See the Appendix for a listing of error codes and their meanings. 

WinSteam Version 3.2 - User's Manual 



Chapter 2 - Using the Steam Property Functions  Page 7 

2.3 ALTERNATE UNIT SYSTEMS 

The WinSteam functions directly support two main unit sets, English units and the 
International System of Units (SI), and two variants within each for a total of four unit sets.  The 
table below summarizes the units used for each parameter in either system. Use the unit set 
name or number to identify which unit system to use in each WinSteam function call.   

 

Unit Set English SI  
Customary 

English 
 Gauge 

SI 
Formal 

SI kPa Metric Metric Formal 

Unit Set Number 0 1 2 3 4 5 6 
Unit Set Name "ENG" "SI" "ENGG" "SIF" "SIK" "MET" "METF" 
Temperature °F °C °F K °C °C °C 
Pressure Psia Bar Psig Mpa kPa Bar kg/cm2 
Enthalpy Btu/lbm kJ/kg Btu/lbm kJ/kg kJ/kg kcal/kg kcal/kg 
Entropy Btu/lbm/°F kJ/kg/°C Btu/lbm/°F kJ/kg/°C kJ/kg/°C kJcalkg/°C kJcalkg/°C 
Specific Volume Ft3/lb m3/kg Ft3/lb m3/kg m3/kg m3/kg m3/kg 
Quality Non-Dim Non-Dim Non-Dim Non-Dim Non-Dim Non-Dim Non-Dim 
Specific Heat Btu/lb/°F kJ/kg/°C Btu/lb/°F  kJ/kg/°C kJ/kg/°C kcal/kg/°C kcal/kg/°C 
Thermal 
Conductivity 

Btu/hr/ft/°F Watt/m/°C Btu/hr/ft/°F Watt/m/°K Watt/m/°C Watt/m/°C Kcal/m/h/°C 

Dynamic 
Viscosity 

lbm/ft/hr Centipoise lbm/ft/hr Pa-sec Centipoise Centipoise Centipoise 

Isentropic 
Expansion 
Coefficient 

Non-Dim Non-Dim Non-Dim Non-Dim Non-Dim Non-Dim Non-Dim 

Sonic 
Velocity 

ft/sec m/sec ft/sec m/sec m/sec m/sec m/sec 

 

In all cases, make sure the units used and produced by these functions are compatible 
with the unit system of any formulae you use.  Otherwise, make further conversion part 
of the cell equation. 

The selection of unit set is made with each function call by the use of an extra argument, which 
designates the unit set (see section 2.2).  In addition to allowing selection of the unit sets 
described above, the Unit Set parameter is also used to select which formulations to use (see 
section 2.4) and to select the non-iterative mode (see section 2.5). 

Including the unit set argument with each function call allows the following important features: 

1. The user can include functions in both English and SI units on the same 
spreadsheet. 

 
2. Because the choice of unit set is recorded with each function used on the 

spreadsheet, it insures that anyone using that spreadsheet will automatically use 
the correct unit sets. 

 
The WinSteam add-in for Excel allows two modes of operation.  In one mode, the unit set 
argument is optional and the units default to English units if the argument is omitted. In the 
other mode, the unit set argument is mandatory.  If omitted, the functions will return an error 
value. 
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The optional unit set mode was included to allow the use of older files, which may not have 
used a unit set argument.  If you do not need to use such files, Techware recommends that 
you make the unit set argument mandatory.  You select this option during the installation 
process.  If you wish to change the mode, run the setup program again. 

If you have selected the optional argument mode and are creating a new spreadsheet, it is 
recommended that you enter the unit set argument anyway.  This will assure consistency with 
future versions of WinSteam, which may not allow optional unit set arguments.  In addition, this 
documents the unit set you are using so that there is no confusion. 

2.3.1 Using Alternate Unit Systems 
The unit set argument is always the last input argument to the function call.  For the functions 
StmTempIT, StmTempTI, StmPT or StmTP it is the second argument; for all the others it is 
entered as the third argument.  For convenience, the unit set can be selected by entering 
either a number (e.g., 0 for English units or 1 for SI units) or a string (e.g., "ENG" for English 
units or "SI" for SI units) or reference to a cell which contains one of these values.  If a string is 
used, it can consist of upper or lower case characters and may contain any number of leading 
blanks.  The function checks the first few non-blank characters for a match (e.g. 3 characters 
for "ENG" and 2 for "SI").  If it finds a match, the function checks the remaining characters for 
unit set modifiers and ignores any other characters including blanks.  For example, the string "  
Engl" would be accepted as a match and cause the function to use English units; but the string 
" En" would not be accepted as a match as the function would return an error.  For Mathcad, 
the unit set can only be entered as a number. 

The following examples show several valid uses of the WinSteam functions with unit set 
arguments: 

Function Called from Cell Formula 
STMPT, English 1-2-3 @STMPT(150,0) 
STMPT, English Excel =STMPT(150,0) 
STMPTH, English 1-2-3 @STMPTH(2400,1000,"Eng") 
STMPTH, English Excel =STMPTH(2400,1000,"Eng") 
STMTP, SI 1-2-3 @STMTP(10,1) 
STMTP, SI Excel =STMTP(10,1) 
STMPTS, SI 1-2-3 @STMPTS(165,538,"SI") 
STMPTS, SI Excel =STMPTS(165,538,"SI") 

 

Note that both the input values and the return values must use whichever unit set is selected 
for a particular function.  For example, if the function @StmPT is used in Lotus 1-2-3 with SI 
units, then the function expects the input value to be in units of  "bar" and the return value will 
be in units of "deg C". 

2.3.2 Selecting Operating Modes 
The WinSteam add-in for Microsoft Excel allows two modes of operation as outlined above.  
One mode makes the unit set argument optional (defaults to English).  In the other mode, the 
unit set argument is mandatory. 

The operating mode is determined when the add-in is loaded into Excel based on an entry in 
the Windows registry made by the WinSteam installation program.  The user chooses whether 
the unit set parameter will be mandatory or not during the installation process.  If need to 
change the selection arises, simply re-run the installation program. 
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2.4 USING THE IAPWS IF97  OR 1967 IFC FORMULAS 

To instruct a WinSteam function to use the old 1967 IFC formulations instead of the default 
IF97 formulations, append the character ‘o’ or ‘O’ to the unit set name.  For example, to select 
English units using the 1967 IFC formulations, the unit set argument would be “EngO”.  If you 
prefer to use numbers instead of the mnemonics, just add 8 to the unit set number.  In this 
case the unit set number would be 8 (0 for English plus 8 for 1967 formulations.) 

WinSteam has no functions returning sonic velocity or isentropic expansion coefficient using 
the 1967 IFC formulations.  If you invoke this option using one of these functions, it will be 
ignored and WinSteam will use the IF97 formulations instead. 

2.5 NON-ITERATIVE MODE 

The IF97 formulations include special inverse functions to calculate temperature when 
pressure and enthalpy or pressure and entropy are the input variables.  While these functions 
return good results, they are not as accurate as the other forward functions.  As a result, 
WinSteam normally uses these inverse functions as a first approximation, then iterates to 
achieve the same level of accuracy as the other functions.  You can disable the iterative 
feature and instruct a WinSteam function to use just the inverse function by appending the 
character ‘s’ or ‘S’ to the unit set name.  For example, to select English units using the fast 
formulations, the unit set argument would be “EngS”.  If you prefer to use numbers instead of 
the mnemonics, just add 16 to the unit set number.  In this case the unit set number would be 
16 (0 for English plus 16 for fast formulations.) 

The fast formulations are not available with the 1967 IFC formulations.  If you include the fast 
formulation option with the old formulations or with any forward function, it will be ignored. 

2.6 VALID RANGE 

WinSteam produces results for the full range identified by either the 1967 IFC or the IF97 
formulations.  WinSteam allows pressures up to 16,000 Psia (110.32 MPa) for both 
formulations.  The official IAPWS release cites a limitation in the IF97 formulations to a 
pressure of 100 MPa, but ASME recommends the use of these formulations up to 110.32 MPa.   

WinSteam allows temperatures varying between 30 ºF and 1600 ºF (1144.3 ºC) when using 
the 1967 IFC formulations. The IF97 formulations limit temperature to 1472 ºF (800 ºC) for 
pressures above 1450.3 psia (10.0 MPa) but adds a new region, which extends the 
temperature range up to 3632 ºF (2000 ºC) for pressures up to 1450.3 psia (10 MPa). 

2.7 VERSION AND SERIAL NUMBER 

There may be new releases of WinSteam to add features or to support new applications.  
Each new release of WinSteam will have a different version number.  Every licensed copy of 
WinSteam also has a unique serial number.  You can identify the version of the WinSteam 
and serial numbers of your copy by using the StmVer function, which takes no arguments.  In 
Excel, an empty pair of parentheses is needed.  In 1-2-3 no parentheses are needed.  The 
StmVer function returns a floating-point number containing the information (e.g., 3.212345).  
The first three digits indicate the DLL version number.  The next five digits make up your 
copy's serial number. 
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2.8 UPGRADING FROM PREVIOUS VERSIONS 

WinSteam 3.2 is directly forward-compatible with all of Techware’s steam property add-ins for 
Excel introduced over the past several years.  Most users will not need to make any changes 
to existing spreadsheets.  WinSteam 3.2 also maintains the same general function-set and 
calling conventions of various steam property add-ins produced by Techware since 1989.  So, 
conversion of even your oldest spreadsheets is readily feasible.  For help in converting older 
spreadsheets, please see the FAQ section of our web site. 

The WinSteam add-in for Lotus 1-2-3 97 does not allow optional arguments within the 
functions.  For this reason, the unit set argument is mandatory with each function call.  If you 
are upgrading a file created with an earlier version of 1-2-3 for Windows and have not included 
the optional unit set argument, the steam functions will return an error value.  You must edit 
each steam function call and insert the missing unit set argument to eliminate the error. 
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3. USING DESKTOP STEAM 

3.1 OVERVIEW 

DeskTop Steam is an interactive replacement for tables of the thermodynamic properties of 
steam.  It eliminates the need for time consuming look-up and interpolation.  It automatically 
calculates all unknown properties when a state point is defined by two known properties.  The 
program is flexible, and designed to minimize keystrokes for common calculations. DeskTop 
Steam allows you to enter any number of state points, label them and store the collection of 
points for later reference.  You can print a table of stored points or copy them to the clipboard 
and paste them into your favorite spreadsheet or word processor. 

DeskTop Steam is a standard Windows application including a menu and toolbar at the top of 
its window and a status bar at the bottom.  It employs common keystrokes and mouse 
movements to activate its various menus, buttons, check boxes, input fields, and list boxes.  
For example, the Tab key can be used to move among buttons and input fields.  Please refer 
to your Windows manual for a description of the fundamentals of the Windows interface. 

The program uses the IAPWS-IF97 formulations by default but you can select the IFC-67 
formulations by selecting the Use IFC 67 command from the Tools/Formulations menu.  The 
results of calculations appear on the screen almost instantly.   

Major features of this program include: 
• consistency with IAPWS-IF97 or IFC-67 values 
• validity over full range defined by the ASME 
• flexible  interactive design 
• full choice of units used for each property 
• quick response time 
• on-line help screens 

If you choose to use the IFC-67 formulations, the high temperature range is not available 
because it is not defined under the older formulations.  In addition, the sonic velocity property 
is not available when using the IFC-67 formulations. 

DeskTop Steam also includes a turbine expansion tool, which analyzes steam turbine 
expansion efficiencies.  If you input the efficiency, it will calculate the end point; if you input the 
endpoint, it will calculate the efficiency.  The expansion tool also calculates the steam rate and 
shaft energy. 

If installed using the default settings, DeskTop Steam is started by simply clicking on its 
name/icon in the TechwareEng Group appearing in the Windows Program Menu. 
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3.2 INPUT COMBINATIONS AND CALCULATION 

DeskTop Steam arranges the display in a tabular format, which remains constant although the 
program window can be resized.  You may sometimes find it convenient to make the program 
window smaller.  Each of the twelve rows in the table is dedicated to one of the thermodynamic 
(pressure, temperature, quality, enthalpy, entropy, and specific volume) or transport properties 
(specific heat, dynamic viscosity, thermal conductivity, Prandtl number, and critical velocity).  
After recalculation, the twelve fields contain values for steam or water at a particular state 
point. 

Five properties are commonly used in describing steam state points: temperature, pressure, 
enthalpy, entropy, and quality.  Theoretically, a point can be uniquely identified by specifying 
any two of the six thermodynamic properties.  This is seen on a Mollier diagram as the 
intersection of two lines which represent two variables.  In most practical applications, 
however, pressure and one other variable will be known.   Acceptable combinations are: 

• Pressure and Temperature 
• Pressure and Enthalpy 
• Pressure and Entropy 
• Pressure and Quality (wet region only) 
• Temperature and Quality (wet region only) 
 

Choose the desired combination of inputs by checking the corresponding combination of check 
boxes.  The program will not let you select invalid combinations.  Variables that cannot be 
combined with existing selections are 'grayed.'  Uncheck one or more variables to enable other 
input combinations.  Enter values for the selected input variables then press the on-screen 
button labeled 'Compute' to calculate all corresponding state point values.  Pressing <ENTER> 
on the keyboard is equivalent to pressing the 'Compute' button. 

You can enter input data only for five of the thermodynamic properties including pressure, 
temperature, quality, enthalpy and entropy.  The text boxes for these five properties are special 
dual-purpose boxes called input/output boxes or I/O boxes for short.  If you enter a value in 
any of the I/O boxes, it is interpreted as input and a red “X” appears to the left of the box to 
indicate that new input data has been entered.  After a Compute command is issued 
successfully, all I/O boxes are interpreted as output and the red “X’s” are removed. 

To enter values, choose the property by clicking on the desired I/O box with the left mouse 
button or press the tab key until the desired box is selected.  If you wish to enter new data, 
double click the left mouse button to select all the text in the box.   

You may enter either a number or an expression in the box.  A number can be entered in 
either decimal or scientific notation.  The expression can be any valid arithmetic expression 
using the following operators: 

+  add 
- subtract 
* multiply 
/ divide 
^ exponent 
( ) parentheses 
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Arithmetic calculations can be nested to any level using parentheses. An example of a valid 
expression is: 

((1004^2 + 997^2) / 2)^.5 

which evaluates to 1000.506. 

When you are finished entering the number or expression in the I/O box, you may move to 
another control or else press the <ENTER> key.  In either case, the number or expression 
entered in the box will be evaluated and its value will be displayed in the box.  If the input is 
accepted, a red “X” will be displayed to the left of the box indicating that this is a new input 
value that is not consistent with the other values displayed.  If the text typed in the box cannot 
be evaluated to a number, you will hear a beep, focus will be returned to the box and the first 
offending character will be highlighted.  You must fix the error and try again. 

If the expression you are entering is too long to fit in the I/O box, the box will temporarily 
increase in length so that you may view more of the expression.  When the edit mode for the 
I/O box is cancelled, the box will return to its original length. 

If you wish to edit an expression typed in an I/O box, select the I/O box and then issue the 
Recall Expression command from the Edit menu (or press the F2 key).  The last number or 
expression entered in that I/O box will be displayed and the I/O box will be in the edit mode.  
Note that the I/O box retains the last number or expression entered even after a Compute 
command is issued.  As a result, the value in the box may not reflect the value of the 
expression. 

3.3 UNIT SELECTION 

DeskTop Steam allows you to use any combination of units for input and output properties.  
The units for each property can be set independently by using its associated pull down box. To 
change a unit, select its list box and scroll through the list of available units using either the 
keyboard cursor arrows or the mouse.   Whenever a new unit is selected, the program 
converts the values displayed for that property in both the current point and the stored point 
value boxes.  Therefore, when entering data it is best to first select the units and then key in 
the input values.  Otherwise, the values will be converted and you will have to re-enter them. 

The first time the program is started, the SI unit system is automatically selected.  You may 
choose any combination of available units for your default set.  Simply select the units you 
desire as described above and issue the ‘Use Settings as Default’ command from the Format 
menu.  The next time you start DeskTop Steam, your unit set will be used. 

If you change units and then save a file, those selected units will be restored whenever the file 
is opened.  If you wish to change the units back to your default units all at once, issue the 
command ‘Restore Default Settings’ from the Format menu. 

You can change all the units to either standard English or SI units by issuing the ‘English units’ 
or ‘SI units’ command from the Format menu.  For an even easier method, just press the ‘Eng’ 
or the ‘SI’ button on the toolbar. 
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Make sure to always note the units displayed when using values from DeskTop Steam.  
The program makes it so simple to change units that it can be easy to lose track of the units in 
use. 

Unit system changes in DeskTop Steam do not affect use of WinSteam from any other 
applications (e.g., Excel, 1-2-3, etc.). 

3.4 CALCULATING STATE POINTS 

When you have finished entering values for the selected input variables, press the on-screen 
button labeled 'Compute' or the <ENTER> key to calculate all corresponding state point 
property values. 

Notice that the <ENTER> key performs two different functions depending on what you are 
doing.  Once you begin typing any text in an I/O box, DeskTop Steam is in the edit mode.  
While in the edit mode, pressing the <ENTER> key causes the text in the I/O box to be 
evaluated.  If the evaluation is successful, the edit mode is cancelled.  If you are not in the edit 
mode, pressing the  <ENTER> key is equivalent to pressing the 'Compute' button.  

If you have just finished typing data in the last I/O box that requires input data, then you must 
either press the <ENTER> key twice to compute the properties (once to accept the data in the 
I/O box and a second time to give the ‘Compute’ command), or else just click the ‘Compute’ 
button with the mouse. 

3.5 STORING STATE POINTS 

You have the option of labeling and storing state points for future reference.  You can store 
any number of points in the DeskTop Steam calculator.  This collection of state points can be 
saved as a DeskTop Steam project file.  In addition, you can print the state points in a tabular 
form or copy them to the clipboard, where they can be transferred to another application such 
as a spreadsheet program or word processor. 

After calculating a state point, the focus is shifted to the state point label box.  DeskTop Steam 
will automatically label the point in a sequential manner as “Point 1”, Point 2”, etc., but you 
probably will want to rename the point with something more meaningful to you, such as “Main 
Steam”, or “Turbine Exhaust”.  You should keep the names short if you plan on printing the 
data or else the label may not fit in the printed column. 

Some users prefer to enter the label before calculating the point.  If you do so and the label is 
unique, DeskTop Steam will not change your label. 

When you are satisfied with the label, press the ‘Store Point’ button and the values displayed 
for the Current Point will be added to your collection of points.  The state point that you have 
just stored will be displayed in the right-most column of DeskTop Steam.  You can view any of 
the stored points using the drop down list box at the top of the Stored Points column. 

DeskTop Steam requires all stored points to have a unique label.  If you try to store two points 
with the same label, DeskTop Steam will query whether you wish to replace the stored point, 
which has the same label, with the current point.  If not, you should rename the current point 
and try to store again. 
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To use a stored point to calculate another point, use the drop down list box to select the stored 
point you want, then press the Recall Point button.  The values of the stored point will be 
copied to the Current Point column.  You may then change one or more parameters and 
recalculate a new state point. 

You can also replace stored values with those in the Current Point by using the Replace Point 
button.  The stored point’s label and all the property values will be replaced with those from the 
Current Point, even if the labels are the same. 

You can eliminate the stored point currently displayed in the stored point column by using the 
Delete Point button. 

All of these storage operations can be performed from the Edit menu as well. 

All state point values that you store will retain the properties calculated using the formulations 
in effect at the time of the calculation.  For example, suppose you calculate a state point using 
the IF-97 formulations and store it, then change the formulations to IFC-67.  The stored point 
will retain the values calculated using the IF-97 formulations but any new point calculated or 
stored will be based on the IFC-67 formulations.  If you recall the point the current point will still 
show the IF-97 values.  If you execute a Compute command, the current point will now be 
recalculated with the IFC-67 formulations using the two selected properties as input values. 

Since you can change back and forth between the formulations, the storage array may contain 
a mixture of points calculated with both formulations.  You may wish to add a notation to the 
state point label to identify the formulations used. 

3.6 STEAM TURBINE EXPANSION TOOL 

This tool opens a dialog box that is used to calculate a steam path expansion from the current 
state point to another state point at a lower pressure.  The first column identifies 5 
thermodynamic properties; (P) pressure, (T) temperature, (Q) quality, (H) enthalpy, (S) entropy 
and the units currently in use on DeskTop Steam’s main window.  The second column, labeled 
‘Expand From’, shows the properties of the starting state point, which was copied from the 
current point on DeskTop Steam’s main window.  The third column, labeled ‘To’, will hold the 
results of the expansion calculation.  You define the expansion process by specifying the 
conditions for the end point.   

The box below the columns allows you to choose the input variables for the calculation.  
Typically, if you are trying to predict the performance of a steam turbine section, you probably 
know the end point pressure and the turbine section efficiency.  You will notice that those are 
the only two I/O boxes that are enabled for you to enter data.  If instead, you are trying to 
analyze the performance of a turbine section from either a heat balance or actual plant data, 
you will know the end point pressure and perhaps enthalpy, temperature or quality (if the 
endpoint is in the wet region.)  Select the button that corresponds to the data you have and 
notice that only the I/O boxes for your selection are enabled. 

Enter the data in the I/O boxes just as you did on the DeskTop Steam’s main window and 
press the ‘Compute’ button or the <ENTER> key.  The expansion calculation will be completed 
and the ‘To’ column will display the properties at the end point.  If you did not enter efficiency 
as one of the input variables, the section efficiency will be calculated for you.  In addition, the 
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expansion energy (the energy converted to shaft power) and the steam rate will be calculated.  
The units for these results will be consistent with your input units but you may change the units 
from the drop down list box below the values. 

You may change any of the data and repeat the calculation as required.  When you are 
satisfied with the result, you may copy that state point back to the current point on DeskTop 
Steam’s main window by pressing the ‘Close and Copy to Current Point’ button.  There, you 
can label and store the point is desired.  If you do not wish to use the expansion state point, 
just press the ‘Cancel’ button. 

3.7 USING THE HELP SCREENS 

The Help menu offers extensive on-line help for DeskTop Steam.  The 'About' item in the Help 
menu presents the version and serial numbers of your copy of WinSteam. 

3.8 ERROR MESSAGES 

When input values are out of range or any other errors occur, a message box is displayed 
describing the error.  The calculated fields will not be updated until the error condition is 
resolved. 

3.9 EXITING DESKTOP STEAM 

You may exit DeskTop Steam by using any of the standard methods for closing Windows 
applications.  These include the following: 

• Click the upper left corner of its program window and select close from the menu. 

• Selecting  Exit from the File menu. 

• Press Alt + F4 keys. 

• Click the “X” button in the upper right corner of the program window 
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4. SPEED AND ACCURACY CHARACTERISTICS 

4.1 SPEED OF CALCULATIONS 

This section addresses the steam property calculation speed as measured within Microsoft 
Excel.  Performance within other applications is similar.   

The time required to recalculate a spreadsheet is a function of many features of the computer 
system hardware and the nature of the spreadsheet. Technically, the time required to perform 
the calculations also varies depending on the variables used as inputs and the region of the 
state point.  Calculations near the critical point are slower than those in other regions.   
Calculations that use pressure and temperature as inputs run the fastest.  However, today’s 
processors perform floating-point calculations so quickly that they are able to perform any 
useful set of calculations involving steam properties instantly for all practical purposes.  For 
example, we have found that a 350 MHz Pentium II computer can execute in excess of 12000 
function calls per second.  

4.2 ACCURACY OF CALCULATIONS 

The calculations performed by WinSteam have been checked extensively against the values 
published by the IAPWS in the paper titled “Release on the IAPWS Industrial Formulation 1997 
for the Thermodynamic Properties of Water and Steam” which was published in Erlangen 
Germany in September of 1997.  This paper provides the formulations for calculating steam 
properties in 5 different regions.  Region 1 is compressed liquid; region 2 is superheated 
steam; region 3 is the critical region; region 4 is the saturation line and region 5 is the high 
temperature superheated region.  In each region, the paper provides several test points printed 
to 9 significant digits.  For all the points printed for regions 1, 2, 4 and 5, WinSteam 3.2 
matches the published values exactly when using pressure and temperature as the input 
values.   

In the critical region, the equations are based on temperature and volume instead of pressure 
and temperature.  Since WinSteam does not have a function that uses temperature and 
volume as inputs, the comparison is made using pressure and temperature as inputs.  The 
WinSteam functions use iterative procedures to calculate the properties in region 3 and should 
not be expected to achieve the same level of accuracy.  In fact, the WinSteam functions 
actually match most of the properties to the full 9 digits.  In the worst case, the functions are 
accurate to 7 significant digits. If you would like to review the results in detail or to run the test 
on your own system, please visit our web site for more information. 

In general, greatest accuracy is achieved when temperature and pressure are the input 
variables.  Other combinations of inputs require iterative solutions, which apply tolerances of 
about .0000001%. 
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APPENDIX   

WINSTEAM DLL ERROR CODES 

If an error is encountered by a function during calculation of a steam property, it returns a 
negative value (-1000 or more negative).  This Appendix presents the error numbers together 
with an explanation of each possible error condition.  The header file STMERR.H defines 
mnemonic constants for the error codes.  The mnemonics are listed below also. 

The error codes listed below are accessible only from programming languages like C++ or 
Visual Basic.  The interfaces provided for Excel and 1-2-3 intercept these error numbers and 
return appropriate Excel or 1-2-3 error values.  This is done to avoid inadvertent use of an 
error value in a cell equation.  In Mathcad, an error message is printed in a box near the 
function. 

If you have developed programs using earlier versions of WinSteam be aware that the 
numeric values of the error codes has changed to accommodate the fact that some properties 
have negative values when using some of the new unit systems.  Nine new codes have also 
been added to make it possible to better identify the cause of an error. 

ERR_THIGH(-1000): Temperature Exceeds Program Limits 
 

WinSteam will accept a maximum temperature of 1600 deg F for pressures greater than 1450 
psia or up to 3632 F for lower pressures.  Any attempt to calculate steam properties at 
temperatures above these points will generate this error. 

ERR_TLOW(-1100): Temperature Too Low 
ERR_PLOW(-1300): Pressure Too Low 

 

WinSteam does not handle thermodynamic properties below a pressure of 0.088 Psia or a 
temperature of 30 º F.   

ERR_PHIGH(-1200): Pressure Exceeds Program Limits 
 

WinSteam will accept a maximum pressure of 15700 Psia.  Any attempt to calculate steam 
properties at pressures above this point will generate this error.  

WinSteam Version 3.2 - User's Manual 



Appendix – WINSTEAM DLL Error Codes Page 19 

ERR_PLOWSAT(-1300): 
Pressure too low for saturation. 
 

ERR_TLOWSAT(-1100): 
Temperature too low for saturation. 

 
ERR_THIGHSAT(-1900): 

Temperature too high for saturation. 
 
ERR_PHIGHSAT(-1900): 

Pressure too high for saturation. 
 

There is no saturated state at pressures or temperatures above the critical point, (3200.11 
Psia, 705.10 º F) or below the triple point (0.088 Psia, 32.018 º F). Outside this range, two 
properties other than quality are required to define a state point.   

ERR_CRITCONVERGENCE(-1500): 
Failed to converge within critical region. 
 

All property calculations near the critical point are iterative.  (Find a temperature/volume 
combination that matches the requested inputs.)  This error indicates a failure of this iteration.  
Contact Techware if this error occurs. 

ERR_NOTINRANGE(-1500): 
Either temperature and/or pressure are beyond range of the steam 
property routines. 
 

For the thermodynamic properties, WinSteam will accept only pressures in the range of 0.088 
Psia to 15700 Psia.  For all pressures, it will accept temperatures in the range of 30 º F to 
1600 º F.  For pressures up to 1450 psia, it will accept temperatures up to 3632 ºF. 

ERR_INTERNAL(-1600): 
Internal error. 
 

An error occurred within the steam property calculation routines even though the inputs were 
within the allowable range.  This could be the result of a convergence failure in an iterative 
function.  Call Techware if this error occurs. 

ERR_QUALWRONG(-1700): 
Quality input is incorrect. 
 

The steam property functions only accept input quality between 0 and 1.0 inclusive. 

ERR_PNOTSAT(-1800): 
Pressure outside of saturation range. 
 

The saturated state of water occurs only at pressures between the triple point (0.08865 Psia) 
and the critical point (3208.1 Psia). 

ERR_TNOTSAT(-1900): 
Temperature outside of saturation range. 
 

The saturated state of water occurs only at pressures between the triple point (32.018 º F) and 
the critical point (705.10 º F). 
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ERR_NOTAVAILABLE(-2000): 
Property requested is not available at the input conditions. 
 

Transport properties are not available in the wet region.  Specific heat is not available at the 
critical point.  Sonic velocity and isentropic expansion coefficient are not available in certain 
wet areas. 

ERR_HLOW(-2100): 
Enthalpy too low. 
 

The input enthalpy places the point at a temperature that is too low for the input pressure. 

ERR_HHIGH(-2200): 
Enthalpy too high. 
 

The input enthalpy places the point at a temperature that is too high for the input pressure. 

ERR_SLOW(-2300): 
Entropy too low. 
 

The input entropy places the point at a temperature that is too low for the input pressure. 

ERR_SHIGH(-2400): 
Entropy too high. 
 

The input entropy places the point at a temperature that is too high for the input pressure. 

ERR_NOCONVERGENCE(-2500): 
Internal error. 
 

An error occurred within the steam property calculation routines even though the inputs were 
within the allowable range.  This could be the result of a convergence failure in an iterative 
function.  Call Techware if this error occurs. 
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